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Concepts Review

True/False Questions

Each of the following statements is either true or false. Indicate your
choice by circling T or F.

T F 1. Dragand drop stores text on the clipboard.

T F 2. The content of the Office Clipboard is replaced each time you copy or
cut text.

T F 3. The keyboard shortcut for cut is (Ctr]+(C).

T F 4. You can drag text between two documents when both windows are
maximized.

T F 5. The Cut, Copy, and Paste commands are all available from the shortcut
menu.

T F 6. The only difference between cut and copy is that selected text remains
in the document after copying.

T F 7. When you move a paragraph, you should select the blank line following
it to preserve proper line spacing.

T F 8. When a document is split into panes, you can remove the split by
double-clicking the split bar.

Short Answer Questions

Write the correct answer in the space provided.

1. How can you copy text without using the Clipboard?

2.  Which buttons on the Ribbon, Home tab, do you use to move text?

3. What is the keyboard shortcut for moving between two documents?

4. For which command is [Ctrl]+(V] the keyboard shortcut?

5. Which command displays all open documents at the same time?

6. What is the keyboard shortcut to undo?
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7. What is different about the drag-and-drop pointer when you are
copying, as opposed to moving, text?

8. Where is the split box located?

Critical Thinking

Answer these questions on a separate page. There are no right or wrong
answers. Support your answers with examples from your own experience,
if possible.

1. Many people once wrote first-draft documents by hand or by using a
typewriter. In either case, people would then literally cut and paste
pieces of their document together and type a final draft. Some people
say that word processing—specifically moving and copying text—has
caused a basic change in the way people write. What do you think?
Explain your answer.

2. You have learned different methods for moving text by using cut and
paste. You also learned the drag-and-drop method of moving text.
Which method do you prefer? Why? Include advantages and
disadvantages.

Skills Review

Exercise 6-16

Move text to a new location by using cut and paste and by dragging.

1. Open the file Property.

2. Display the Office Clipboard by following these steps:
a. Click the Home tab, and click the Clipboard Dialog Box Launcher.
b. Click Clear All if there are any items in the task pane.

3. Use keyboard shortcuts to move text by following these steps:

a. Click the insertion point at the beginning of the line that starts
“Equipment — office.” Press and hold (shift]). Click at the end of the line
beginning “Key employees.”

b. Press [Cti)+(X] to cut the text.

c. Position the insertion point to the left of the line that begins “Types of
coverage.

d. Press [Ctl)+(V] to paste the text. Press to add a line space between
the paragraphs.
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4,

10.
11.

Drag text by following these steps:
a. Select the text “All employees” through “Customers.”

b. Point to the selected text. Press and hold down the left mouse button
to display the drag-and-drop pointer and the dotted insertion point.

c. Drag the dotted insertion point to the left of the word “Research,”
and release the mouse button.

d. Press after “Customers.”
Use the Ribbon to cut and paste text by following these steps:

a. Select the text “Fire” through “Loss of income.”
b. Click the Cut button |#|.

c. Position the insertion point at the beginning of the line that starts
“Who to cover.”

d. Click the Paste button | 7.
e. Press [Enter].

Select “Types of insurance.” Press and select “Types of coverage,”
“Who to cover,” and “Research.”

Apply 12-point bold, small caps format to the selected text. A blank line
should precede each heading.

Clear and close the Office Clipboard by following these steps:

a. Click Clear All to remove all Clipboard items.
b. Click the task pane’s Close button [X].

Select the title of the document, and change it to 14-point bold
uppercase, and apply 72 points spacing before and 24 points spacing
after.

Save the document as [your initials]6-16 in your Lesson 6 folder.

Submit and close the document.

Exercise 6-17
Copy text by using copy and paste and by dragging.

1.
2.

Open the file Stores - 2.

Display the Office Clipboard, and clear the Office Clipboard if it
contains any items.

Select text in the document beginning with “Pennsylvania” through the
end of the document.

. Set a left tab at 2 inches on the ruler.

. Position the insertion point to the right of “Grove City,” and press (Tab).

Key Carole Walters.
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11.

12.
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19.
20.
21.
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Use the Office Clipboard to copy text by following these steps:

a. Select the tab character (—) and “Carole Walters.” (Do not select the
paragraph mark at the end of the line.)

b. Click the Copy button |2 to copy the text to a Clipboard.
c. Position the insertion point to the right of “Meadville.”
d. Paste the text by clicking the Clipboard.

Position the insertion point to the right of “Clarksburg” and press (Tab).
Key Rebecca Surrena.

Select the tab character and “Rebecca Surrena,” and press [Ctri)+(C] to
place the selected text on a clipboard.

Position the insertion point to the right of “Fairmont,” and press
C+)

Use the drag-and-drop method to copy “Carole Walters” by following
these steps:

a. Select the tab character and the text “Carole Walters.”

b. Point to the text. Press and hold down (cui}); then click and hold down
the left mouse button.

c. Drag the dotted insertion point to the right of the word “Mercer,” and
release both the mouse button and (Ctrl).

Click to the right of “Butler,” press [Tab), and key Cynthia Rhodes. Select
the tab character and the text you just keyed, and copy it to the
clipboard.

Click to the right of “Akron,” press (Tab), and key Jane Daniels. Select the
tab character and the text you just keyed and copy it to the clipboard.
The clipboard should contain four names. Paste the text “Jane Daniels”
to all cities listed under Ohio.

Use the Clipboard task pane to paste the text “Carole Walters” to the
following cities: Edinboro, Erie, Sharon, Greenville, and Franklin.

Use the Clipboard task pane to paste the text “Rebecca Surrena” to
Morgantown and Wheeling.

Use the Clipboard task pane to paste the text “Cynthia Rhodes” to New
Castle, Pittsburgh, and Monroeville.

Bold and center the two lines at the top of the document. Format the
first line in all caps and 16 points and 72 points spacing before. Format
the second line in small caps and 14 points.

Format each of the state names as bold, italic, and small caps.

Select the text from “Pennsylvania” through the end of the document,
and format the selected text with a 1-inch left indent. Drag the left tab
marker on the ruler to 4 inches.

Clear and close the Office Clipboard.
Save the document as [your initials]6-17 in your Lesson 6 folder.

Submit and close the document.
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Exercise 6-18

Split a document into panes.

1.
2.

REVIEW

Open the file Favors - 2

Split the document into two panes by double-clicking the split box
above the View Ruler button || and the vertical scroll bar.

. In the top pane, use the scroll bar to display the list beginning with

“wedding bells” through “other assorted shapes.” Format the selected
text as a bulleted list.

. In the bottom pane, scroll to the list that begins with “solid milk

chocolate.” Sort the list alphabetically.

5. In the bottom pane, format the list of chocolate squares
as a bulleted list.

Click the Sort button in the Paragraph 6. Remove the split by double-clicking the split bar.
group on the Home tab

Figure 6-12

9.
10.
11.

7. Scroll through the document to view the changes.

. Apply bold formatting to the title and change the spacing before to

72 points and the spacing after to 24 points.
Place the insertion point in the title line and apply a bottom border.
Save the document as [your initials]6-18 in your Lesson 6 folder.

Submit and close the document.

Exercise 6-19

Arrange windows to move and copy text.

1.

Start a new document. Key the text shown in Figure 6-12, and format it
as a standard business memo. Use single spacing and 0 points spacing
after for the body of the memo, and include today’s date. Format the
first line of the heading to include 72 points spacing before.

Memo to Robert Smith from Pete Barnes

Subject is Vehicle Reports

Please review the following, and let me know if the
information provided is compatible with the new fleet
management software.

Mileage numbers will be provided the first of each month.




3. Simultaneously open the files Vehicle and Maintenance.

10.

11.
12.
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Save the document as [your initials]6-19 in your Lesson 6 folder.

Arrange the documents by following these steps:

a. Switch to Maintenance if necessary, and minimize it by clicking the
Minimize button [T

b. Display the other two documents at the same time by clicking the
View tab and clicking Arrange All.

Drag a paragraph between documents by following these steps:

a. In the [your initials]6-19 window, scroll to display the sentence
beginning “Mileage numbers.”

b. In the Vehicle window, select the entire document by pressing
(Ctr)+(A).

c. Holding down to copy, drag the paragraph to the [your
initials]6-19 window until it precedes the paragraph beginning
“Mileage.” Select the copied text and change the line spacing to single
and the spacing after to 0 if necessary.

Close the Vehicle document and restore the Maintenance document by
clicking its taskbar button.

Use View tab, Arrange All to display [your initials]6-19 and
Maintenance at the same time, if necessary.

. In Maintenance, select the text beginning “Scheduled Maintenance

Guide” through the blank line preceding “10,000 miles.” Copy and paste
this text to the end of [your initials]6-19. If necessary, add a blank line
before “Scheduled Maintenance Guide.” If necessary, change the line
spacing to single and the spacing after to 0.

Close the Maintenance document without saving it. Maximize [your
initials]6-19. Format the entire document in 12-point Cambria. Insert
your reference initials at the bottom of the memo.

Select “Vehicle Listing” and “Scheduled Maintenance Guide,” and
format each heading with 14-point bold and small caps. Format the
column headings of the tabbed text to bold, small caps, and underlined.

Save the document again.

Submit and close the document.
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Exercise 6-20

Move and copy text.

1.
2.

8.
9.

Open the file OH Stores - 2.

Move the address text for the Cleveland store to follow the address text
for the Canton store.

Click on the blank line following the Akron address, and key the
following text on two lines. Press after each line.

Telephone:
Fax:

Select “Telephone:” and “Fax:” and copy the text to the Clipboard.

Paste the copied text at the end of each address using [F4) to repeat the
past action.

Format the document heading as uppercase, bold, and 14 points with
72 points of spacing before and 24 points of spacing after. Delete the
blank paragraph mark below the heading.

Apply bold-italic and small caps formatting to each store name. (Hint:
Use Format Painter or select each store name before applying the
character format.)

Save the document as [your initials]6-20 in your Lesson 6 folder.

Submit and close the document.

Exercise 6-21

Copy and move text in a memo.

1.
2.

Open the file Walk.

At the top of the document, insert a memo heading to the staff from
you, using today’s date.

Move the first line in the document (which begins “Getting ready”) to
the subject line, and apply italic formatting. In the subject line, replace
“walk” with a copy of the words “Chamber of Commerce Walk-a-Thon”
found in the paragraph that begins “Here is.” Apply the appropriate
capitalization to the subject line.

. Delete the punctuation at the end of the subject line and extra blank

lines below the subject line.
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5. In the paragraph that begins “Once again,” move the last sentence
(beginning with “We are”) to the end of the document as a separate
paragraph.

6. At the top of the document, combine the paragraphs that begin “Once
again” and “Here is.”

7. In the paragraph that begins “We need,” delete the words “We need a
volunteer to” and capitalize the next word “check.”

8. Format the three action paragraphs, beginning “Arrange,” “Check,” and
“Contact,” as a numbered list.

9. Format the two uppercase and blue headings as
uppercase, bold, black, and with 6 points of spacing

after them.
REVIEW
10. Save the document as [your initials]6-21 in your

Remember to add your reference initials Lesson 6 folder.

to the memo.
11. Submit and close the document.

Exercise 6-22
Copy text from multiple documents into an existing document.

1. Open the file Holtz. Copy the inside address and salutation. Close the
document without saving.

2. Create a new document. Click the Home tab. Locate the Styles group,
and click the No Spacing button in the Styles gallery.

3. Insert the date using the Insert tab on the Ribbon. (Use appropriate
format for a business letter.) Press four times, and paste the copied
text. Format the date with 72 points spacing before.

4. For the first paragraph of the new letter, key the text shown in
Figure 6-13.

Figure 6-13 I am looking forward to your visit to Grove City in June.

You will be staying at the Wolf Creek Hotel as our guest.

5. From the file Wolf Creek, copy the second paragraph, beginning “The
hotel has 200 rooms,” and paste it at the end of the paragraph you
keyed in step 4. Delete the last sentence in the paragraph.

6. Start a new paragraph by keying When you arrive, the Strawberry Days
Arts and Music Festival will be in full swing.

7. From the file Summer, copy the last sentence of the first paragraph,
and paste it at the end of the sentence you just keyed. Edit the
beginning of the sentence to “You can enjoy.”
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8. Key the text shown in Figure 6-14 as a closing paragraph.

Figure 6-14 Jack, I am delighted that you are coming to Grove City! I

know you are going to have a great time at the Festival
and touring our facilities.

9. Add an appropriate closing. The letter is from Thomas Campbell,
President.

10. Check for correct spacing, and spell-check the document.

11. Save the document as [your initials]6-22 in your Lesson 6 folder.
Submit and close the document.

12. Close all other open documents without saving them.

Exercise 6-23 @ Challenge Yourself

Copy text from multiple documents to create a new document.

1. Start a new document. Key the title WEST VIRGINIA CONTACT
INFORMATION in 12-point Arial. Center the title and apply bold
formatting.

2. Insert two blank lines after the title.

3. Save the document as [your initials]6-23 in your Lesson 6 folder. Keep
the document open.

4. Open the files Stores - 3, WV Managers, and WV Stores.

5. Refer to the three open documents to create a new document that
includes the name and complete address for each store, the telephone
and fax numbers for each store, the name of the store manager, and the
name of the account executive.

6. Use tabs to arrange the text attractively.

7. Format document headings to include character and paragraph
formatting.

8. Add 72 points of spacing before the first line in the document (the title).
Increase the size of the title to 14 points.

9. Save the document again.

10. Submit and close the document.
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In these exercises, you work on your own, as you would in a real-life
business environment. Use the skills you’ve learned to accomplish the
task—and be creative.

Exercise 6-24

Write a short proposal for implementing a change in your city,
neighborhood, or school. Make the proposal at least three paragraphs long.
At the end of the document, create a bulleted summary of the proposal,
copying and pasting text from the proposal for the bulleted items. Save the
document as [your initials]6-24 and submit it.

Exercise 6-25

Copy text from the Internet about a person (present day or historical) you
admire. Use Paste Options to paste the text, without formatting, into a new
document. Apply your own character and paragraph formatting. Save the
document as [your initials]6-25 and submit it.

Exercise 6-26

Write a summary about a TV show or video you have recently seen. Save

it as [your initials]6-26a. Keep this document open, and start a new
document. Begin a letter to a friend, telling him or her about the TV show
or video. Copy and paste or drag and drop text from the summary document
into the letter. Save the document as [your initials]6-26b and submit both
documents.



